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Welcome to Portfolio 10

Portfolio is a powerful, easy to implement digital asset management and media delivery solution. As an open and
centralized platform, Portfolio gives you control over all aspects of management and delivery of digital assets.
Portfolio lets you easily deploy content to marketing, image management, and web-based on demand solutions.

About this Guide

This guide covers the very basic installation and configuration of Portfolio components on a server and a client
system. These instructions only cover a common setup. Your needs may vary based on your users, hardware
configuration and other options.

Before deploying Portfolio Server, we recommend examining how you want digital asset management to fit into
your workflow. For sample configurations and detailed server options, please see the Portfolio Server
Administration Guide.

Setup Overview

Here are the steps you will need to complete to set up Portfolio on a server and a desktop (client) computer.

1. Verify the System Requirements.
Make sure your server and desktop systems meet or exceed the specifications in the System Requirements.

2. Install prerequisite software on your server.
You need to have QuickTime installed on your server. You should also install the OpenOffice.org office
suite and Adobe’s DNG Converter software for certain features of Portfolio to work. Portfolio relies on
OpenOffice.org to index and preview Microsoft Office documents and RTF and HTML files, and can use
the DNG Converter to export Camera Raw images in Adobe’s Digital Negative (DNG) format.
Macintosh users: When installing prerequisite software, you must log in to the computer using the same
account that you intend to use to install and run Portfolio Server.

3. Configure your firewall.
If there is a firewall between your server and users that need to connect to it, you must open some ports
on the firewall to allow Portfolio Server to communicate with its client software. If your firewall is on your
server, open these ports to allow others on your network to access the server; if your firewall is between
your network and the Internet, open these ports to allow users outside your network to access your
server.
You should make sure these ports are open before installing Portfolio Server.

4. Install Portfolio Server.
Windows users: Determine in advance whether you need to use the Domain User account option or the
Local System account option.
Macintosh users: When you install Portfolio Server, be sure to log in to the computer using the same
account you used to install OpenOffice.org and the Adobe DNG Converter software.

5. Enter your Portfolio Server serial number.

6. Create a catalog.

7. Add users.
You can manually create native Portfolio or Directory Service user accounts and grant users access to the
catalog. Enterprise users can also map users and groups from a directory service to the catalog.

8. Install any prerequisite client software.
Client access using a web browser requires Adobe’s Flash Player and a modern browser (a recent version
of Firefox, Safari, or Internet Explorer). Desktop Clients need QuickTime installed to support audio and
video playback.

9. Install the Portfolio Desktop Client.
While your server has a limit to how many users can be connected at one time, you can install the client
software on as many desktop computers as you want.

10. Connect to the server from the client.

Make sure your connection is working and client accounts have the appropriate access.



Set Up Portfolio Server

Upgrading Portfolio from a Previous Version

If you have specific questions about upgrading, please visit the Extensis support page
(http://www.extensis.com/support/). Here you can search the Portfolio Knowledgebase, visit the user forums,
and contact technical support.

NOTE

If you require assistance upgrading, and have an Annual Service Agreement, please contact Priority Technical
Support using the number on your contract.

Preparing for Directory Services (Enterprise)

Starting with Portfolio Server 10, you can bind your Portfolio Server to an Active Directory or Open Directory
service and map users and groups to Portfolio catalogs. If you intend to use this feature, you can prepare
Portfolio user accounts by changing their names to match their directory service account names.

For example, if Joe Doakes has a Portfolio account named JoeDoakes, and his network login name is
jdoakes, then you can change his Portfolio account name to jdoakes (or JDoakes, or JDOAKES). When you
map his directory service account (or a group that includes his account) to a Portfolio catalog, then synchronize
the Portfolio Server with the directory service, his Portfolio account will be promoted from a Native account to a
Directory Service account.

Upgrading Portfolio Server 9.x

IMPORTANT

Macintosh users need to be sure to log in to the Portfolio Server computer using the same account that the
server was installed under.

Copy changed port values

1. Open your web browser and start the Portfolio Server Admin application.

2. Click Ports in the list on the left.

3. Compare the Values column with the default values listed. Make a note of any port values that have
changed.

4. Click Status on the left, then click stop Server.

5. Close your web browser.

Stop the server

1. Click Status on the left, then click stop Server.
2. Click Log out.
3. Close your web browser.
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Back up existing catalogs

NOTE
Back up SQL-based catalogs using the applications provided with your chosen SQL database.

o Copy Portfolio’s catalogs folder to a safe location. By default, the folder is in one of the following
locations:
Macintosh:/Applications/Extensis/Portfolio Server/applications/native-
server/Catalogs/
64-bit Windows:C: \Program Files (x86)\Extensis\Portfolio
Server\applications\native-server\Catalogs\

32-bit Windows:C:\Program Files\Extensis\Portfolio Server\applications\native-
server\Catalogs\

Install or update OpenOffice.org

1. Download the latest version of OpenOffice.org from http://download.openoffice.org/index.html.
2. Install OpenOffice.org.

3. Start the application and go through the configuration wizard.

4. When prompted about updates, be sure to choose not to check for updates.

5. Exit OpenOffice.org.

Install or update other software

e Download and install the latest version of QuickTime from http://www.apple.com/quicktime/download/.
Macintosh users: Choose Software Update from the Apple menu to make sure you have the latest
version.

¢ Download and install the latest version of Adobe Flash from http://get.adobe.com/flashplayer/.

¢ Download the and install latest Adobe DNG Converter from one of these locations:

Macintosh: http://www.adobe.com/support/downloads/product.jsp?product=106&platform=Macintosh
Windows: http://www.adobe.com/support/downloads/product.jsp?product=106&platform=Windows

Account name (Windows only)

1. Open the Services console (on Windows Vista/Windows 7, click Start > Administrative Tools > Services; on
Windows XP, click Start > Programs > Administrative Tools > Services).

2. Look in the Name column for Portfolio Server, then look in the Log On As column for the domain and
account name. Make a note of this.

Install Portfolio Server

1. Run the Portfolio Server installer. You can download the latest version from
http://www.extensis.com/downloads/.
Windows users: When you are asked for Domain\User, enter the domain and account name you noted
above, and the password for that account.

2. At the end of installation, the Portfolio Server Admin application will start.

At this point, any native catalogs that you have will be upgraded as well. SQL catalogs will be upgraded

when you enter a license number for the Enterprise Solution Pack.

Log in using the account name administrator and your original password.

Click Licenses in the list on the left and enter your Portfolio license number.

Next, enter the license for Enterprise Solution Pack if you have one.

You can also enter a NetMediaMAX license at this point; however, this requires restarting Portfolio Server,

so we suggest waiting until you complete the other upgrade steps.

6. If you had previously changed any port values, then click Ports in the list on the left and enter the values
you made note of earlier.

7. If you have a NetMediaMAX Solution Pack license, then click Licenses on the left and enter that license
number, then restart Portfolio Server.

oro®
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Changes to be aware of
If you are upgrading from Portfolio Server 9.0.x or 9.1.x

¢ Portfolio Server now handles file previews much differently. Previews are stored locally on the server, and
for each catalog you can choose to have preview files generated automatically or not. If you turn this
option on, previews are displayed very quickly for Web and Desktop Client users but more disk space is
used on your server; if you turn this option off, previews are generated on demand for Web and Desktop
Clients, so previewing may be a bit slower but this uses much less disk space.
In the Portfolio Server Admin application, you can change this setting; click Catalogs, choose a catalog,
click View/Edit Catalog Details, then click the Previews tab.

o Portfolio Server has consolidated its log files. They are now all stored in one location, listed in the Global
Settings/Logging Configuration panel of the Portfolio Server Admin application.

¢ When you create new catalogs, you can create an AutoSync folder for the catalog on the server. This
allows Web Client users to start adding items to the catalog immediately. You can enable this as a default
in the Global Settings/Catalog Defaults panel of the Portfolio Server Admin application.

e Portfolio Server recognizes more metadata types stored in Microsoft Office files; your users may wish to
re-catalog Word, Excel, and PowerPoint files to capture this information.

o Portfolio Server adds a shortcut on your server’s desktop. You can double-click this icon to start the
Portfolio Server Admin application, even if you change the port used for administration.

If you are upgrading from Portfolio Server 9.5.x or earlier

o Portfolio Server adds a shortcut on your server’s desktop. You can double-click this icon to start the
Portfolio Server Admin application, even if you change the port used for administration.

System Requirements and Release Notes

For the most up-to-date information about the latest release of Portfolio Server, please visit the Extensis website
at http://www.extensis.com/en/support/documentation/?fs=portfolio.

Install Me First

NOTE FOR MACINTOSH USERS

Be sure to log in to the computer using a single account to install OpenOffice.org, DNG Converter, and Portfolio
Server.

QuickTime

To support many video file types, as well as some other functions, Portfolio Server requires QuickTime. This is
particularly important for Windows, since it’s not installed by default. On Mac OS X, use Software Update to
make sure that the most current version is installed.

Download QuickTime from: http://www.apple.com/quicktime/download/

Even if you don’t think you will be cataloging video files, it is highly recommended that you install QuickTime so
that Portfolio Server will appropriately respond to these file types.

NOTE
QuickTime Pro is not required. The basic version of QuickTime provides the necessary functionality.

OpenOffice.org

In order to catalog some document formats (Microsoft Word, Excel, and PowerPoint, HTML, and RTF) you must
install and run OpenOffice.org before you install Portfolio.

Download OpenOffice.org from: http://download.openoffice.org/index.html

OpenOffice.org is not required to use Portfolio Server to catalog other file types, but must be installed to support
Microsoft Office documents and other formats.
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Adobe DNG Converter

Portfolio can catalog Camera Raw files from most digital cameras. Since these files are not standardized, Adobe
developed the Digital Negative (DNG) file format to provide compatibility among a wide range of devices and
applications.

If you have the free DNG Converter application installed on the Portfolio Server computer, Portfolio can batch
convert Camera Raw files to this popular format.

Download the latest DNG Converter from one of these locations:
Macintosh: http://www.adobe.com/support/downloads/product.jsp?product=106&platform=Macintosh

Windows: http://www.adobe.com/support/downloads/product.jsp?product=106&platform=Windows

The DNG Converter is not required to use Portfolio Server but, if present, provides an additional conversion
option.

Opening the Firewall Ports

If there is a firewall between your server and users that need to connect to it, you will need to open several ports
to allow communication between Portfolio Server and the Client applications.

o |If your firewall is on the server itself, you will need to open these ports to allow access to other users on
your network.

o If your firewall is between your local network and the Internet, you will need to open these ports to allow
access to users outside your network.

Port Description

2903 Desktop Client

8090 Web Client (JBoss HTTP/Web Service)
8091 Server Administration (Jetty Web App)

Additional ports must be reserved for internal Portfolio Server communication. See the Portfolio Server
Administration Guide for complete details about all required ports and port conflict resolution.

Install Portfolio Server

For best performance and simplicity, you should install Portfolio Server on your file server.

You can download the current Portfolio Server installer from the Extensis website at
http://www.extensis.com/downloads/. Copy the installer onto the server’s hard disk, double-click to launch the
installer and follow the instructions.

When the server software has been installed, your Web browser will open Portfolio Server Admin to allow you to
configure your server, add users, and create catalogs.

Installing on Windows

Installing Portfolio Server is quick and easy. Download the installer to the server, double-click the installer and
allow it to guide you.

During the installation process on Windows, you are prompted to optionally enter a Domain User account or
install as a Local System account.

Domain User account option

If the assets you intend to catalog reside on network volumes, you must use the Domain User account option.
To take advantage of this option, you will need to create the Domain User account (ideally, specifically for the
Portfolio Server services) and configure its access before running the Portfolio Server installer. The account must
have full read/write access to all network locations that contain your files to catalog, as well as the location of
preview files generated by Portfolio. This domain account is also used to run the Portfolio Server services


http://www.adobe.com/support/downloads/product.jsp?product=106&platform=Macintosh�
http://www.adobe.com/support/downloads/product.jsp?product=106&platform=Windows�
http://www.extensis.com/en/downloads/�

(Portfolio Server, Portfolio Server Admin). The account must be a member of the local Administrators group, so
that it has full control over the Portfolio Server program directory and system files.

In addition, the domain user account must be granted the Log on as service privilege in the Local Security
Policy console. For more information, see http://technet.microsoft.com/en-us/library/cc739424(WS.10).aspx.

Local System account option

If Portfolio Server is installed on a Windows system that holds all of the files you intend to catalog and make
available to users of Portfolio Server, there is no need to configure a Domain User account for network access.
You may select the Local System option.

Installing on Macintosh

Installing Portfolio Server is quick and easy. Download the installer to the server, double-click the installer and
allow it to guide you.

When installing on a Macintosh, the Portfolio Server runs as the user that is logged in to the system at the time
of installation. It is important to note the account must have full read/write access to all local and network
locations that contain files (including Previews) you intend to catalog and make available to users of Portfolio
Server. Don’t log out if you have remote shares mounted.

In order to allow Portfolio Server access to network locations for files and previews, the shares need to be
mounted on the system where Portfolio Server is installed. Portfolio Server will then have access to these
network locations. For best performance, you may choose to install Portfolio Server on the same computer as
your file server.

NOTE

If you use the Portfolio Desktop Client on a Macintosh to connect to Portfolio Server on another Macintosh, the
computer running the Desktop Client software needs to have the same network volumes mounted that are
mounted on the server. This ensures that both the client and server have the same path to assets and previews.

Xsan users

Portfolio Server can catalog files on Xsan volumes whether they are accessible to the server or not, but
cataloging and file access performance will be dramatically improved if the server is directly connected to the
Xsan volumes.

Continue configuration

At the end of installation, Portfolio Server Admin opens in your Web browser so that you can configure your
server.

The server administrator username is administrator and the default password is password. Usernames and
passwords are case sensitive.
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The Portfolio Server Admin application

You can use the Portfolio Server Admin application to configure or change your Portfolio Server from any
computer on your network.

To open Portfolio Server Admin:

1. Open your web browser.

2. Inthe address field, enter your server IP address followed by a colon and then the port number. The
default server administration port is 8091.
For example: http://192.168.0.1:8091 or http://localhost:8091.

3. Enter the administration username and password and click Login.
The administrator username is administrator and the default password is password. Usernames and
passwords are case sensitive.

NOTE

At your earliest convenience, you should change the Administrator password. In the Server Admin application,
click Users in the panel on the left, click administrator, then enter and confirm the new password and click

Apply.

Enter Your Serial Number

In order to use Portfolio Server, you need to enter your serial number in the Portfolio Server Admin application.

To license Portfolio Server:

Open Portfolio Server Admin and log in as administrator.

If the Licenses panel is not open, click Licenses in the panel on the left.

Click the [ + ] button at the bottom right of the window to add a license.

Enter your Portfolio Server serial number and click Add License.

The Licenses panel shows the version number of Portfolio Server and how many seats your license
includes.

PN

NOTE

After you have entered your serial number, a Configure button will be displayed. Click this button for a checklist of
details to configure for your server.

You use this same process to add licenses for add-on services or upgrades such as NetMediaMAX. (You enter
the serial number for NetPublish Server from within the Portfolio Desktop Client application.)
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Create a Catalog

A Portfolio catalog stores all of the information about your assets. Catalogs do not store the physical assets, but
include each asset’s location on disk.

To create a Portfolio catalog:

poN~

o

7.

Open your web browser and start the Portfolio Server Admin application.

Click Catalogs in the left hand panel.

In the Catalog list, click Add New Catalog.

Specify a catalog type.

Typically, the General Use catalog type fits most needs.

Choose a database type:

Native FDB: This is the default Portfolio Server database type.

SQL database: If you are using the Portfolio Server Enterprise Solution Pack, you can choose to use an
SQL database. See the Portfolio Server Administration Guide for complete details about installing and
configuring an SQL database for Portfolio Server.

Enter a catalog name.

If your users will catalog files using the Web Client, you should consider creating an AutoSync folder to
immediately create a location they can upload files to.

You can also specify options for Collation language and Previews at this point or at any time after you
have created your catalog.

Click Create.

Catalog Defaults

You can specify default settings (such as user access level) for new catalogs; see the Portfolio Server
Administration Guide or the online help system.

Add Users

To access a Portfolio catalog, users must have an account. The server administrator creates user accounts and
grants users membership to catalogs in Portfolio Server Admin.

To add a new user:

oM~

Start your web browser, open the Portfolio Server Admin application, and log in as administrator.
Click Users in the panel on the left.

Click Add New User.

Enter New User Details:

Account Name: The name the user will log in to Portfolio with. (Required)

Authentication: This setting is available for Pro and Enterprise users. Choose Native (Built-in) for user
accounts that will be validated by Portfolio Server. Choose Directory Service for accounts that will be
validated by an LDAP directory service.

For Directory Service accounts, the Account Name you enter must be the user’s account name in the
Directory Service that is bound to the Portfolio Server. The user’s password will be the same as their
Directory Service password. The Full Name and Email address will be filled in with information from the
Directory Server.

Password: The password for this account. (Native Authentication; Required)

Confirm Password: Re-type the password. (Native Authentication; Required)

Full Name: The user’s real name. (Native Authentication; Optional)

Email address: An email address where the user can be contacted. (Native Authentication; Optional)
Notes: Any additional information about the user or their account. (Optional)

Access: To specify a user’s default access to existing catalogs, check the box labeled Add user to all
catalogs as and choose an access level. If you uncheck this box, you will need to add the user to
individual catalogs manually.

Click Create.
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Mapping LDAP users to a Portfolio Catalog

The server administrator can map users from an LDAP directory service to a Portfolio Catalog.

You can also create and manage Portfolio user accounts within the Portfolio Server Admin application,
independently of the directory service.

To add a directory service:

1.
2.
3.

4.

Start your web browser, open the Portfolio Server Admin application, and log in as administrator.
Click Directory Services in the panel on the left.

In the Configure Directory Service panel, enter the connection settings of your directory service.
Hostname: The IP address or DNS name of your directory service.

Port: Enter the LDAP connection port (the default port is 389).

If SSL is required, select the Use SSL option and update the port accordingly (the default port for LDAP
using SSL is 636).

Type: Select your directory service type, Active Directory (Microsoft Windows) or Open Directory (Mac
0OS X).

LDAP Bind Username: Enter a username that has permission to query the directory service. How you
enter the username varies by the type of directory service you are using.

For Active Directory, enter the username as domain\user (mycompany\ jsmith), user@realm

(3 smith@mycompany.com, or the fully qualified LDAP distinguished name

(uid=jsmith, cn=users, dc=MYCOMPANY, dc=COM).

For Open Directory enter the username as either the domain username only (3 smith) or the fully qualified
LDAP distinguished name (uid=jsmith, cn=users, dc=MYCOMPANY, dc=COM).

Password: The password for the LDAP Bind Username.

Synchronize Daily: Select this option to have Portfolio Server automatically synchronize with your LDAP
server once a day. If you do not enable this option, synchronization is only performed manually.

Click Create.

To map directory service users and groups to a Portfolio catalog:

1.

ok

In the Configure Directory Service panel, click View/Edit Mappings.

The View/Edit Mappings panel consists of two parts: the Service Browser on the left, that lists users
and groups, and the Mapping on the right, that lists the users mapped to a catalog.

Choose the catalog to map to from the Target Catalog drop-down menu in the Mapping panel on the
right.

Select entries in the Search Results on the left.

Click create Mapping at the bottom of the Service Browser.

Click save Mapping. This will cause Portfolio Server to synchronize to the directory service, and add the
specified users to the selected catalog.

See the Portfolio Server Admin Guide or help system for more details on using a directory service with Portfolio.

-12-



Set Up the Web Client
Configure the Web Client

The Portfolio Web Client consists of a supported web browser with Flash Player installed. Recent versions of
Firefox, Internet Explorer, and Safari are supported; for the full list of supported browsers see the System
Requirements.

To download the latest version of Flash Player for your system, visit http://www.adobe.com/flashplayer/.

Of course, in order for a Web Client to connect to the Portfolio Server, the appropriate ports in the server’s
firewall must be opened for external traffic. See Opening the Server’s Firewall Ports and the Portfolio Server
Admin Guide for more information.

You can specify default view settings for each catalog. See Setting Default Views for the Web Client in the
Portfolio Server Admin Guide and online help.

Finally, potential Web Client users must have a user account and access to a catalog. See Add Users and the
Portfolio Server Admin Guide.

Accessing a Catalog from the Web Client

To connect to Portfolio Server, you must fist have the access information from your Portfolio Server
Administrator. This includes the following information:

The Portfolio Server IP address or server name
The Portfolio Server’s port number

Your username

Your password

To connect to Portfolio Server:

1. Open a supported web browser.

2. Inthe address field, enter the IP address or server name followed by a colon and then the port number.
(The default port for connecting to Portfolio Server is 8090.)
For example: http://192.168.0.1:8090 or http://servername:8090

3. Select your preferred language from the drop-down menu.

4. Enter your username and password and click Login.

The Portfolio Web Client

The Portfolio Web Client has four major areas:

e Toolbar: Located across the top of the Web Client. The Toolbar provides access to common functions
such as uploading and downloading files and changing the look of the Main Window.

e Organizer: Located on the left side. This displays the catalogs available to you.

e Main Window: Located in the center of the Web Client. This area displays item thumbnails and other
information for the selection in the Organizer, or the results of a catalog search.

¢ Item Properties: Located on the right side. This displays system file and metadata for items selected in
the Main Window. Many of these fields can be edited directly in this pane.

When you preview an individual item, you will see the preview itself, a filmstrip for choosing other items to
preview, and other navigational controls.

For details on using the Web Client, click Help in the Web Client toolbar or see the Portfolio Web Client User
Guide.
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Set Up the Desktop Client

Install the Desktop Client

The Portfolio Desktop Client can be used by any Portfolio user to browse, search, and update catalogs. The
Desktop Client can also be used by a Catalog Administrator to create AutoSync folders, custom fields, and the
Master Keyword list.

Before you install the Portfolio Desktop Client, make sure that the computer you are installing on meets the
minimum system requirements, and that the latest version of QuickTime is installed.

Download the current Portfolio Server from the Extensis website at http://www.extensis.com/downloads/. (The
download includes Portfolio Server, Desktop Client, and NetPublish Server.) Copy the Desktop Client installer
onto the computer, double-click to launch the installer and follow the on-screen instructions.

NOTE

On Mac OS X, you will need to quit any other programs you are running. Some installed components need you
to log off your computer then log back on in order to complete installation. The installer will prompt to log you off
when installation is complete.

Accessing a Catalog from the Desktop Client

To open a catalog from the Desktop Client, you need to connect to the server.

NOTE

In order for the Desktop Client to connect to the Portfolio Server, certain ports in the server’s firewall must be
open to external traffic. See Opening the Server’s Firewall Ports and the Portfolio Server Admin Guide for more
information.

1. Start the Portfolio Desktop Client.
2. Choose File > Connect to Server.
3. Click Add server.
4. Enter a name to identify your server and the IP address or network name of the Portfolio Server, then click
Add.
The server name can be anything and does not have to be related to its network name or computer name.
5. In the Connect to Server window, click the [ + ] icon next to the server name to see the catalogs on that
server.
Select a catalog and click Open Catalog.
Enter your username and password and click ok. (To use administration features, enter a Catalog
Administrator username and password.)
If you check the box labeled Open this catalog on startup, the next time you start the Desktop Client
you will be prompted for your password and this catalog will open.

No
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The Desktop Client

There are four main areas in the Desktop Client:

e Toolbar: The Toolbar is at the top of the Desktop Client window. It provides access to common functions,
including QuickFind, and you can customize it to include the buttons you want.

o Galleries: The Galleries list is on the left side of the window. Galleries are containers you can create for
organizing and displaying items from your catalogs. The Galleries pane shows the galleries for your open
catalogs.

o Folder View: Use Folder View for instant access to folders on your computer or network. You can also
configure folders here for AutoSync.

NOTE

On Mac OS X, Folder View is available on a window drawer; on Windows, it is in a pane below the
Galleries pane.

e Main Window: The Main Window shows items from the currently selected gallery or folder. Double-click
an item to preview it.

For details on using the Desktop Client, see the help system or the Portfolio Desktop Client User Guide.

Administration Functions in the Desktop Client

The Portfolio Desktop Client allows users with Catalog Administrator access to perform some administration
functions.

When you open a catalog using a Catalog Administrator account, you can:

Create, delete, and manage AutoSync folders;

Create, delete, and manage Custom Fields and predefined lists;

Manage the Master Keywords list;

Edit additional settings such as Field Defaults, Metadata Settings, and Advanced Cataloging Options.
Set advanced cataloging options (such as thumbnail size and metadata field mapping);

Specify default values for certain fields that are automatically applied when items are added to the
catalog.

For more information on these and other Catalog Administrator tasks, see the Catalog Administrator section of
the Desktop Client help system or the Portfolio Desktop Client User Guide.

Extras

When you install the Portfolio Desktop Client, you also install an operating system level shortcut menu plug-in,
as well as Portfolio Express.

Shortcut menu plug-in

When you right-click on a selection in Windows Explorer or the Mac OS X v10.5 Finder, the shortcut menu
shows a submenu to Add to Portfolio. From this submenu, you can choose a catalog you have previously
opened or choose Other Catalog. Choosing one of these will open the Portfolio Desktop Client and allow you to
add the selected files to a Portfolio catalog.

NOTE

You will still need to enter your username and password, and if you choose Other Catalog, you will first need to
connect to a server and open the desired catalog.
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Portfolio Express

Portfolio Express is a lightweight application that you can launch and leave running. It shows you the contents of
a catalog and lets you search for, preview, and open any files in the catalog. You can also drag a file from the
Portfolio Express window into a document that supports that file’s content to insert the file into the document.
For example, you can drag a graphic into your word processing document.

You can have Portfolio Express start automatically when you log in to your computer, then show or hide its
window by pressing a user-configurable hotkey combination.

See the section on Portfolio Express in the Desktop Client help system or the Portfolio Desktop Client User
Guide.
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Using Portfolio
Cataloging Assets

There are two components to cataloging assets: adding them to a catalog, and adding information about them.

Adding assets to a catalog

You can add asset files to a catalog in one of three ways:

e Manually, using the Desktop or Web Client. You can select single or multiple items to catalog, and with
the Desktop Client, you can catalog entire folders or disks.

¢ Automatically, using AutoSync folders. Even people who don’t use Portfolio can add items to a catalog by
placing them in an AutoSync folder.

¢ Instantly, from the Mac OS X Finder or Windows Explorer. Right-click on a selected group of files or
folders and choose Add to Portfolio from the shortcut menu, then choose the catalog to add the items
to. (This option is only available to computers that have the Portfolio Desktop Client installed.)

A Catalog Administrator can specify Catalog Option presets for Desktop Client users that will automatically add
or prompt for certain information when items are cataloged.

Adding information to assets

While its all well and good to have all your assets cataloged, when it comes time to locate a specific image or
other file you will find that a key to locating the right asset quickly is to have them tagged with useful information.

Information that can be used to locate items in a catalog includes:

¢ ltem thumbnails and previews: Sometimes a visual search is easiest, or can be used to locate a desired
asset from the results of another search. Including high-resolution previews can make this simple.

o Text index: By indexing the contents of text files, PDFs, Word documents, and PowerPoint presentations,
you can search your catalog for files that contain specific words or phrases.

o Keywords: Adding keywords that describe the content of an image or document makes it easy to locate
files. Use the keyword “contract” to identify all Word documents that are contracts, or “woman in hat” to
identify specific fashion photos.

e Custom fields: Add data that has specific meaning to your workflow, such as a creator’s name or an
event date.

¢ File metadata: Digital photographs often include information about the camera model and settings, date
and time the photo was taken, and sometimes the geographical location. Many applications allow you to
embed information in a file, such as the creator name or copyright. Portfolio can import all of this
information automatically when you catalog assets. Make sure in advance that your applications and
devices are set up to embed the information you need.

Catalog users with Editor access can enter and edit information for assets that have been cataloged, using the
Desktop or Web Clients.

Catalog Administrators can create custom fields and add master keywords to catalogs using the Desktop Client.

You can specify Catalog Options to include some asset information automatically, or to prompt the user adding
items to include certain information. See the Desktop Client online help or the Portfolio Desktop Client User
Guide for more information about Catalog Options and Presets.
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Accessing Assets

Once you have cataloged your digital assets, you will want to access them for a variety of reasons: you may
need to make changes to a document or use an image in a presentation, for example.

You can access cataloged assets through the Desktop or Web Client. The Desktop Client gives you more
options for working with files directly; with the Web Client, you must download an asset to your computer to use
it.

Downloading assets with the Web Client

When you download multiple assets with the Portfolio Web Client, they are first added to a . z1P archive. . ZIP
files are used to reduce download time. You can open these files directly in Windows Explorer and Mac OS X
Finder.

To download files:

1. Select the files you want to download.

2. Click Download in the Toolbar.

3. Portfolio Server will prepare the files and create a . z1P archive, then you will be prompted to download
the file now or later. Click ok to download the file.
If you click cancel, the download file is saved as a “job” that you can complete later.

NOTE
If you download just one file, Portfolio does not compress it in a ZIP archive.

4. Your Web browser will prompt you to save the file prepared by Portfolio Server. Choose the location
where you want to save it, give the file a different name if you want to, and click save.

NOTE
Be sure not to change the file’s . z1P extension or you may not be able to open it.

Once the file has downloaded, you can extract the assets from it and use them in your project.

For more information, click Help in the Web Client window, or see the Portfolio Web Client User Guide.

Retrieving assets with the Desktop Client

From the Portfolio Desktop Client, you can do many things with asset files, including:

Edit original files

Copy asset files

Convert an image to a different format
Drag an item into another program

To edit a file:

1. Inany gallery, select the item you want to edit.
2. Press Command-E (Mac) or Control-E (Windows).

Portfolio starts the editing application then opens the selected file in that application. If necessary, Portfolio will
first prompt you to locate the application to use.

To copy a file:

1. In any gallery, select one or more items to copy.
2. Choose Item > Original > Copy.
3. Navigate to the location where you want to copy the files and click choose (Mac) or ok (Windows).

Portfolio copies the files you selected to the folder specified, leaving the original items untouched.
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To convert image files:

oM~

6.
7.

In any gallery, select the items you want to convert.
Choose Item > Batch Convert Images.
Choose the format you want to convert the files to.
Specify other conversion settings:
= For JPEG files, click Settings and specify the compression level.
= Choose a color mode.
= Specify the resolution of the converted images.
= Specify resizing and cropping options.
Specify where to save the new images:
= Prompt for location: When you click convert Portfolio will prompt you for a directory.
* Replace originals: Portfolio will replace the original files with the converted versions.

NOTE
Your originals will be lost if you use this option.

= In the same folder as originals: If converted file names conflict with originals they will have a
number appended to the end; karate. tif will be converted to karatel.tif.
Specify whether you want the new images added to the catalog.
Click convert.

The conversion is done by the Portfolio Server.

Dragging files to other programs

While Portfolio is perfect for managing and organizing your digital assets, you will often need to work with them
in other applications. Besides editing the original files as described above, you can drag items from any Portfolio
gallery into an open document in another application. Some examples of this are:

Drag an image thumbnail from a Portfolio gallery into a Word document to place a copy of the image.
Drag an item into an email to mail a copy of the item as an attachment.

Drag a thumbnail to an application icon to open the original file with that application.

Drag a thumbnail to a folder to copy the file to that folder.
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Organizing Assets

There are several techniques and structures you can use for organizing your digital assets. For a detailed
discussion of the topic, please download the Digital Asset Management Best Practices Guide from Extensis at
http://www.extensis.com/en/downloads/document_download.jsp?docld=4000037.

Here are some basic tips for organizing your assets:

Use multiple catalogs. Catalog assets according to who needs to access them. This means only users
who need to access specific assets need to be granted access to each catalog.

NOTE

Your license for Portfolio Server may limit the number of catalogs that can be online at the same time. To
bring another catalog online, you may need to take a catalog offline first.

Create galleries intelligently. Galleries can give quick access to a subset of assets in a catalog, but will
only be useful if they are created based on the way users access assets. A gallery of files with the digit 1
in the filename will probably not be useful, but a gallery of photos that are royalty-free probably would.
Use private galleries. Private galleries are only accessible to the user that creates them. This can allow
users to organize assets in a way that is meaningful to them but may not be useful to others.

Keep assets on a file server. Although users can catalog assets on their local computers or any network
location, it is much more difficult to manage multiple locations and to make them accessible to other
users. Since digital assets have a distinct value and are often irreplaceable, you should also back them up
regularly. Keeping them on a file server makes this easier to do, also.

Creating a PDF Contact Sheet

To generate a PDF contact sheet from the Portfolio Web Client:

Select the items to include in the contact sheet. To include all items in an organizer, select the organizer.
To make a contact sheet with the last-used settingaclick Make PDF in the Web Client main menu.

To create a contact sheet from a preset, click the icon next to Make PDF and choose one of the
presets fo 1, 2, 4, 9, or 16 items perﬁlge.

To modify preset settings, click the icon next to Make PDF and choose Settings.
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Contacting Extensis

Extensis Extensis Europe
1800 SW First Avenue, Suite 500 Suite 18, Newton House

Portland, OR 97201 Kings Park Road, Moulton Park

Toll Free: (800) 796-9798 Northampton NN3 6LG, United Kingdom
Phone: (503) 274-2020 Phone: +44 (0)1604 654 270

Fax: (503) 274-0530 Fax: +44 (0)1604 654 268

Web: http://www.extensis.com Email: info@extensis.co.uk
Customer Service Celartem, Inc.

Web: http://www.extensis.com/customerservice/ Phone: +81 3 5574 7236

Phone: (800) 796-9798 Email: sales_ap@celartem.com

Web: http://en.celartem.com

Documentation Feedback

Web: http://www.extensis.com/helpfeedback/

Corporate Sales

Web: http://www.extensis.com/corporatesales/
Phone: (800) 796-9798, ask for Corporate Sales

Technical Support

Technical Support is available directly through the Extensis website or by telephone.

Web: Fill out the form at http://www.extensis.com/support/.

A support representative will respond by phone or email, usually within 24 hours on weekdays.
Phone: Please call (503) 274-7030 in North America, or +44 (0) 1604 654 270 in Europe.
When contacting technical support, please include the following information:

Your product name and serial number(s);

Your computer configuration, including operating system, memory, and hard drive configuration;

Your question, or a description of the difficulty you’re experiencing: what specifically occurs and when;
Your phone number if you want to have a representative call you.

Take note of any error numbers or messages that display and any other information you think may be relevant.

For answers to frequently asked questions and troubleshooting tips, you can also visit the Extensis website at
http://www.extensis.com/.

Priority Support

If you have an Annual Service Agreement, you are entitled to priority support. Please call the telephone number
listed on your agreement to receive support 24 hours a day.
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